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Abstract—A variety of social, economic and technological 

factors are converging to transform the nature of higher 

education. Educational institutions are under pressure to 

reduce costs, improve access, and cater to a changing 

population more interested in lifelong learning. Schools 

have responded by spawning a variety of methods and 

technologies for delivering education, including online 

distance learning. This, in turn, is transforming how 

knowledge is delivered. The traditional teacher-focused 

model is being replaced by a learner-centered approach, 

with students taking more proactive control of how and 

when they engage in learning activities, and the instructor 

being more of a coach. This paper gives a detailed 

description of the strategies that were followed in developing 

an online course in Project Management which embodies 

the new approach. Assessments conducted to determine the 

effectiveness of this approach in meeting the course’s 

learning outcomes and to evaluate student reactions to the 

course in its new online delivery mode show high levels of 

student achievement as well as high levels of student 

satisfaction with the course.  

Index Terms—Distance Learning, Outcomes Assessment, 

Project Management, Resource Management. 

I. INTRODUCTION 

A variety of social, economic and technological factors 

are converging to transform the nature of higher 

education. The undergraduate student body is 

increasingly composed of adults from diverse 

socioeconomic backgrounds, most already in the 

workplace, and perhaps with families, seeking the 

education and skills necessary for their careers. This 

change has been accompanied by a transition from 

student to learner, from faculty-centered to learner-

centered curricula, from an emphasis on teaching 

objectives to an emphasis on learning outcomes [1, 2]. 

The learner focus has also led to a drive to reduce cost, 

and increase access and flexibility of course offerings. Sir 

John Daniel, Vice-Chancellor of the Open University put 

it this way: “Any industry whose costs increase faster 

than inflation over a long period is heading for trouble 

either for complete collapse or for unpleasant upheavals. 

We must reduce the costs of higher education." [3] 

Management consultant Peter Drucker commented that 

higher education is in deep crisis meaning that things will 

get either much better or much worse [4].  

It is clear that educational institutions are under intense 

pressure to reduce costs, improve access, and cater to a 

changing population more interested in lifelong learning. 

The responses to these challenges have been quite varied, 

including interactive two-way video conferencing, live 

television broadcasts, computer-based multimedia 

instruction, and increasingly, synchronous as well as 

asynchronous online courses.  

II. DESIGN STRATEGY FOR ONLINE COURSES 

Most students and instructors are used to the traditional 

lecture format, which introduces principles and examples 

of applications, with the textbook providing the details 

and reference material.  The instructor can answer 

questions on the spot and change course if he senses the 

students are not grasping a particular point. For the 

typical online course however, the instructor usually does 

not have the benefit of immediate feedback. Therefore, 

the course has to be deliberately designed to anticipate 

student needs. The roles of both the instructor and the 

students need to change in comparison to those in a 

traditional classroom.  

Because students in online courses do not have to 

follow a set schedule as in the traditional format, they 

have to be much more proactive and self-directed in their 

knowledge acquisition. The instructor becomes more of a 

coach in effect, and students take more active control of 

how and when they engage in learning activities. The 

course learning materials themselves should be designed 

to capture and retain the interest of students, and keep 

them actively engaged with the learning materials. Since 

an online course will inherently be accessed via 

computer, using computer-based animations and 

simulations becomes almost a necessity. Thus, the 

successful online course should build in a mix of the 

following characteristics [5 – 7]: 

 

• Active involvement by students  

• Multiple presentation techniques to capture and 

retain student interest 

• Animations and simulations where appropriate 

• Actual physical models if possible 

• Multiple examples of practical applications 

 
This paper discusses the implementation of this 

strategy in a specific course. For the course under 

discussion, computer-based instructional tools were 

applied in ways intended to capture, engage and keep 

student attention. Solved practical examples and online 

demonstrations were used extensively to enhance student 

learning.  
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III. COURSE DESCRIPTION 

The course that is the subject of this paper is a 

semester-long course titled Engineering Project 

Management. The course provides the student with 

insights into human and organizational behavior affecting 

projects, in addition to the quantitative tools for the 

successful management of engineering projects. The 

course addresses a variety of project types and deals with 

how to select, initiate, plan, execute, monitor, control, 

and when appropriate, terminate a project. The role of 

project managers and their interaction with the rest of the 

organization is highlighted. The pre-requisite is a course 

in college algebra. The textbook used for the course is 

‘Project Management: A Managerial Approach’ by Jack 

R. Meredith and Samuel J. Mantel Jr.; published by John 

Wiley & Sons. The course learning outcomes (CLOs), 

representing the skills and capabilities expected of 

students at the completion of the course, are shown in 

Table 1. 

TABLE I 

 COURSE COVERAGE 

Course Learning Outcomes 

1. Evaluate individual projects and select those that best 

meet organizational needs.  

2. Describe functions and capabilities of a good project 
manager and project team.  

3. Develop a project plan including schedules, milestones, 

and resource needs.  

4. Develop a project budget reflecting the expected costs 

of planned activities.  

5. Use graphical tools such as Gantt charts or Arrow 

networks to represent a project schedule and show inter-
activity relationships.  

6. Allocate the available but limited human and physical 

resources to a project.  

7. Collect appropriate project information and use it to 

ensure that the project proceeds according to plan.  

8. Determine whether a project is meeting its goals and 

when it should end.  

 

The course was first offered in our department in 2008 

in a traditional classroom setting and subsequently 

migrated to online delivery in 2010. It is a required 

course in all the six programs offered in the department, 

and it is offered every semester.  

IV. IMPLEMENTATION EXAMPLES 

The following discussion describes in detail how the 

principles outlined in section II have been implemented 

in this course. To make the discussion more concrete, it 

will focus on the implementation of one CLO. The CLO 

chosen is the allocating resources to a project, which is 

learning outcome #6 in Table I. To capture student 

interest, the topic is presented in the form of a simple 

‘project’ that students can easily understand. This allows 

the instructor to present the underlying principles in detail 

without being lost in the minutiae of the project tasks. 

The project scenario is set up as follows: 

A home-cleaning company has been hired to clean 

out a rental property prior to new tenants moving in. 

The primary cleaning tasks, with the time (in hours) 

needed for each task; as well as the number of 

workers assigned to each task are given in Table II. 

We are interested in the timely execution of the 

project, but also need to carefully monitor the 

utilization of workers on the project since workers are 

the single largest project expense.  

TABLE II 

PROJECT DESCRIPTION DATA 

Task Description Precedent Time Workers 

A Shampoo carpets - 4 2 

B Clean basement - 2 1 

C Kitchen/bathrooms - 3 1 

D Touch up walls A 2 1 

E Dust furniture A 1 1 

 

Each step in the analysis of the problem is 

communicated to students in the form of a PowerPoint 

presentation incorporating relevant explanatory text. The 

first step in the investigation is to generate a fully 

analyzed network diagram for the project. Students would 

have already learned the required process from the 

previous CLO. Fig. 1 shows the resulting network 

diagram for the project. 

 

 

Figure 1: Project Network Diagram 

From Fig. 1, it can be seen that this project can be 

completed in six hours. The network critical path is 

constituted by the tasks ‘Start-A-D-Finish’. Students will 

have learned from CLO5 that an activity along the critical 

path has no slack and if it is delayed, it would result in a 

delay to the whole project. The second step is to generate 

a Gantt chart for the project, assuming that each task is 

done as soon as possible. This can be done conveniently 

in Excel and students would have already acquired this 

skill in CLO5. Fig. 2 shows the resulting Gantt chart in 

this case. This chart goes beyond the standard by 

including the worker demand in each time period for each 

task. The grey stripes represent slack on the 

corresponding activity. The carpets (A), and walls (D), 

have no slack since they are critical tasks. The bottom 

row in Fig. 2 shows the aggregate resource demand for 

each time period. 
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Timeline 1 2 3 4 5 6

Start

Carpets 2 2 2 2

Basement 1 1

Kitch/Bath 1 1 1

Walls 1 1

Furniture 1

Finish

# Workers 4 4 3 2 2 1  
Figure 2: Project Gantt Chart (Including Worker Demand) 

Based on this resource demand profile, four workers 

would need to be assigned to the project to meet this 

schedule. It is visually compelling and informative for 

students to see the resource demand profile in graphical 

form. The aggregate resource loading graph for this 

project is shown in Fig. 3. 

 

Timeline 1 2 3 4 5 6

4 4

3

2 2

1

W
o
rk

er
s

 

Figure 3: Aggregate Resource Loading Graph 

The problem facing the project manager (PM) can be 

clearly seen in Fig. 3. If 4 workers are assigned as the 

current schedule demands, then some of the workers will 

be idle during hours 3-6. This is an undesirable waste! 
The red area represents idle time for the workers. There 

are a total of 8 idle worker-hours in this case. 

One way to address the problem of idle workers is by 

rearranging the timing of some of the tasks involved in 

the project. Advantage is taken of the fact that the timing 

of tasks with slack can be adjusted (within their range of 

slack) without affecting overall project duration. 

Adjustment starts with these tasks. The strategy is to 

reduce overlap among tasks during periods of high 

resource demand. In this case, basement cleaning has a 

slack of 4 hours and is a good candidate for adjustment. 

Fig. 4 shows what would happen if this task is delayed by 

3 hours. As expected, the overall project duration is not 

affected. However, the most interesting observation given 

the context of this discussion is that the resource demand 

profile is changed dramatically. Now, the maximum 

demand is for 3 workers instead of 4.  

 
Timeline 1 2 3 4 5 6

Start

Carpets 2 2 2 2

Basement 1 1

Kitch/Bath 1 1 1

Walls 1 1

Furniture 1

Finish

# Workers 3 3 3 3 3 1  
Figure 4: Revised Project Gantt Chart  

That simple change alone would allow the PM to 

reduce the number of workers assigned to the project, 

without delaying the project. This is eye-opening for 

students. The corresponding resource loading graph is 

shown in Fig. 5. The assigned workers are all busy for 

hours 1-5 and two workers would be idle just for the last 

hour. In this case, there only 2 idle worker-hours, a big 

improvement compared to the 8 idle worker-hours in the 

previous assignment. This strategy assumes that the 

workers are interchangeable between tasks! The PM 

would have to ascertain the validity of the assumption.  
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Figure 5: Revised Resource Loading Graph 

At this point, students are advised that there are 

alternative ways to rearrange the tasks to achieve an 

improved resource demand profile, and are encouraged to 

explore those alternative solutions. 

V. INTEGRATING WITH MICROSOFT PROJECT 

Microsoft Project (MSP) is the most widely used 

project planning software in industry. At this point in the 

course, students would have already been introduced to 

the basic functions of the program and they would know 

how to create a project plan, Gantt chart, and network 

diagram in MSP. The MSP project plan for the example 

under discussion is shown in Fig. 6. 

 

 

 

Figure 6: Project Plan and Gantt Chart in MSP 
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MSP includes features to support the resource 

allocation procedures. These are presented interactively 

in the online course as detailed below. Fig. 7 shows a 

slide from the online course introducing students to the 

use of MSP’s resource allocation functions. Note the 

inclusion of MSP screen shots that help the student to see 

exactly what their work will look like as they work in the 

program. 

 

 

Figure 7: Introduction to Resource Allocation in MSP 

There follows the step-by-step procedural description 

of how to set up resources, and then allocate the resources 

to individual project tasks. The description is interspersed 

with screen shots of MSP so the students can easily 

follow the instructions. Delivering the course in online 

format allows the instructor to give more detailed 

instructions than would be feasible in a textbook. From 

the student perspective, this adds to the value of the 

online delivery. The instructions for allocating resources 

are summarized below: 

� Select View > Resource Sheet (This displays the 

project resources) 

� Select Tools > Options > Schedule  

� Set “Show assignments units as a:” to Decimal  

� Click OK 

� Enter the value 4 in the ‘Max. Units’ column of 

the Resource Sheet. This is the number of 

cleaners available. Do not change any other 

values. 

� Select Resource > Assign people and equipment 

to tasks. (This returns you to the Gantt Chart 

view.) 

� In the task list, select a task to assign resources 

to.  

� In Project Guide pane, select “Assign resources” 

�  Click “Assign” in the new dialog box. 

� In Project Guide pane (scroll to bottom of pane), 

select “Edit task or assignment information”. 

� In the new window set task type to ‘Fixed 

Duration’ 

� In the units column, enter the amount of 

resource required for the task (for example, 2 for 

carpet) 

� Click “OK” in the dialog box, then “Done” in 

left pane. 

� Repeat until all tasks have resources assigned 

� Return to ‘Gantt Chart’ view. To see resource 

utilization graph, select View > Resource Graph  

By following this procedure, students are able to 

generate a resource loading graph within MSP. Fig. 8 

shows the graph that would result for our previous 

example when done correctly. By default, MSP includes 

a lunch break between 12:00 Noon and 1:00 PM. This 

explains the blank space in the middle of the MSP graph. 

It is instructive to compare Fig. 8 to the previously 

generated graph in Fig. 3 

 

 
Figure 8: Aggregate Resource Loading Graph (MSP Version) 

MSP can be used for resource leveling following the 

principles we outlined earlier, namely: when a task has 

slack, its timing can be adjusted within its slack range to 

shift its resource usage. In MSP, this is done by adjusting 

task times manually in the ‘Schedule’ view. To adjust the 

timing of an individual task, the cell representing its early 

start time is changed to some a new value. To adjust 

Clean Basement by three hours for example, the 8:00 

A.M. early start time can be adjusted to 11:00 A.M. 

 

 

Figure 9: Adjusting Task Times to Level Resource Demand in MSP 

MSP asks the user whether to keep or remove any links 

associated with the task when it is adjusted. In this 
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example, the choice was to keep. MSP recalculates the 

new task times automatically, and the Gantt chart is 

redrawn. The resource loading graph will also be redrawn 

automatically. After the change in timing for the ‘Clean 

Basement’ task we have discussed, the resulting MSP 

resource loading graph is shown in Fig. 10. Other than for 

the lunch break, this is comparable to the graph in Fig. 5. 

This procedure can be repeated until the PM comes up 

with a satisfactory resource loading profile. 

 

 

Figure 10: Revised Resource Loading Graph in MSP 

VI. CONSTRAINED RESOURCE ALLOCATION 

Continuing with the investigation of our property 

cleaning example, we next consider a scenario where 

there is a constraint on the number of available workers. 

For example, what if in fact there are only two workers 

available for the project instead of four; how could the 

project be done if at all? Students are informed of 

several heuristic rules that could be used to address this 

situation. For illustrative purposes, this discussion 

considers the ‘minimum slack first’ heuristic, which is 

one of the more popular heuristics for this situation. This 

heuristic requires that available resources are first 

assigned to the task with the minimum slack. Once it is 

assigned resources, a task cannot be interrupted and it 

continues until completed. Applying the heuristic requires 

keeping track of the slack associated with each task. 

Thus, initial project schedule of Fig. 2 can be reformatted 

as shown in Fig. 11 to show slack values.  

 

Timeline 1 2 3 4 5 6 7 8 9 Slack

Start

Carpets 2 2 2 2 0

Basement 1 1 4

Kitch/Bath 1 1 1 3

Walls 1 1 0

Furniture 1 1

Finish

# Workers 4 4 3 2 2 1
 

Figure 11: Template for Constrained Resource Allocation 

Fig. 11 shows that at the start of the project, the task 

Carpets has 0 slack. Thus, this is the fast task to be 

assigned workers. Because the task requires 2 workers 

and there are only 2 workers available, this means that all 

the other tasks will have to wait until the carpets task is 

complete. The other tasks are then scheduled, with care 

being taken to observe the pertinent precedence 

relationships. The resulting project Gantt chart is shown 

in Fig. 12. A negative slack means the related task is late 

by the amount of time shown. 

 

Timeline 1 2 3 4 5 6 7 8 9 Slack

Start

Carpets 2 2 2 2 0

Basement 1 1 0

Kitch/Bath 1 1 1 -1

Walls 1 1 0

Furniture 1 1

Finish

# Workers 2 2 2 2 4 3 1
 

Figure 12: Constrained Resource Loading (Step 1)  

As seen in Fig. 12, now only 2 workers are required for 

periods 1-4. However, periods 5 and 6 are over-allocated 

since they each need more than the 2 workers available. 

Clearly, reallocation is needed. The Kitch/Bath task now 

has minimum slack at -1, so the available workers are 

assigned to it next. The Kitch/Bath task needs only 1 

worker therefore 1 worker would still be available for 

assignment. The second worker can be assigned to either 

Basement or Walls which both have a slack of 0. To 

break the tie, Walls is chosen because it has been critical 

for longer. Once both workers are assigned, the impact on 

the project is reviewed. Fig. 13 shows the results. 

 

Timeline 1 2 3 4 5 6 7 8 9 Slack

Start

Carpets 2 2 2 2 0

Basement 1 1 -2

Kitch/Bath 1 1 1 -1

Walls 1 1 0

Furniture 1 -1

Finish

# Workers 2 2 2 2 2 2 3 1
 

Figure 13: Constrained Resource Loading (Step 2) 

Now, we need to reassess the tasks in period 7, since 

this period has more than 2 workers assigned. The 

Kitch/Bath task already started in period 5, and so its 

assignment can’t be changed. The choice is between 

Basement and Furniture. Basement is assigned first 

because it has minimum slack. Furniture can start once 

Kitch/Bath is complete. Fig. 14 shows the results. Now, 

worker allocation does not exceed 2 workers in any time 

period and so we have a final solution.  
 

Timeline 1 2 3 4 5 6 7 8 9 Slack

Start

Carpets 2 2 2 2 0

Basement 1 1 -2

Kitch/Bath 1 1 1 -1

Walls 1 1 0

Furniture 1 -2

Finish

# Workers 2 2 2 2 2 2 2 2

 

Figure 14: Constrained Resource Loading (Final) 

 

In the final solution, it can be seen that the project will 

be two hours late, but it is accomplished without 

exceeding the resource availability. Would this solution 
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be acceptable to the client? The PM must explore that 

before making the final decision. Note that all tasks are 

now implicitly critical. 

In MSP, resource-limited scheduling is accomplished 

in a manner similar to the above procedure. The 

constraint on available resources is set by adjusting the 

value in the Max. Units column on the Resource Sheet. 

The resource loading graph will show red for any periods 

in which resources are over-allocated. If the value of 

available workers is changed to 2 for the current example, 

then the resource loading graph we had in Fig. 10 

changes to the one shown in Fig. 15. 

 

 
Figure 15: MSP Resource Loading Graph (Over-Allocation in Red) 

Resource over-allocation can be eliminated by 

changing task timing within MSP, similar to the 

procedure above in Fig. 12. Using the ‘minimum slack 

first’ rule, workers are allocated to carpets. The available 

workers are used up so the other tasks have their start 

times changed and moved out of this time slot. This 

process can then be repeated in MSP just like we did in 

Fig. 13 and Fig. 14, until all tasks have been allocated the 

necessary resources. Fig. 16 shows the final MSP Gantt 

chart, and Fig. 17 shows the corresponding Resource 

Loading Graph. 

 

 

Figure 16: MSP Gantt Chart (Final) 

 
Figure 17: MSP Resource Loading Graph (Final) 

The foregoing discussion focused on CLO #6 but the 

same approach was utilized throughout the course. A 

concept would be introduced at the theoretical level, 

illustrative examples or simulations involving real-world 

applications would be presented, followed by exercises 

where students would get to test out their understanding 

and skills. To help students stay on track with the course 

material, homework assignments were given on a weekly 

basis. All assignments were done online except for the 

final exam for which students were required to appear in 

person. 

VII. EVALUATION 

The ultimate impact of a course, whether delivered 

online or in the traditional in-class format, depends on 

what students learn in the course. To that end, two types 

of assessment were carried out to gage the effectiveness 

of this course. The first type of assessment entailed the 

instructor evaluating student performance on each CLO. 

The assessment was in the form of homework 

assignments, tests, and examination problems. 

Performance on the CLOs is a direct measure of student 

outcomes. The second type of assessment was an indirect 

measure where students filled out an end of semester 

survey with a variety of questions covering their reaction 

to the course. 

Table III shows the results of the direct assessment of 

CLOs for this course for one assessment cycle. The target 

for satisfactory performance on each assessment item was 

set at achieving a score of 70%. This target was chosen 

because it would be equivalent to a passing grade on the 

assignment. 

As can be seen in Table III, the assessment tools 

included a mix of homework assignments and several 

tests/exams. To help the reader understand the table, MC 

represents a multiple choice online assignment, Pt2 

represents an online assignment requiring submission of a 

detailed solution file in Word format, P# represents an 

individual problem with a detailed solution procedure. 

The majority of CLOs were assessed multiple times. A 

CLO is considered satisfied if its performance target is 

met in at least one of the assessments.  
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Examination of the assessment results shows that the 

performance targets for CLOs #6 and #7 were not met on 

some of the early assessment measures. This low 

performance led the instructor to provide extra solved 

examples before the end of the semester. The relevant 

concepts were re-tested on the final exam and the 

performance on this was satisfactory in each case, 

indicating that the extra intervention had been effective. 

Consequently, these improvements were deployed on an 

ongoing basis in subsequent offerings of the course. 

TABLE III 

EVALUATION OF COURSE LEARNING OUTCOMES 

Max Mean % 1 2 3 4 5 6 7 8

HW2 MC 88 72 81.8 X Y

HW3 MC 100 78 78.0 X Y

HW4 MC 100 93 93.0 X Y

HW6a MC 70 66 94.3 X Y

HW6b Pt2 30 25 83.3 X Y

HW7 MC 100 85 85.0 X Y

HW8a MC 60 54 90.0 X Y

HW8b Pt2 40 32 80.0 X Y

HW9b Pt2 50 45 90.0 X Y

HW10 P3 40 24 60.0 X N

HW11a MC 50 43 86.0 X Y

HW11b Pt2 50 34 68.0 X N

Final Exam P1 35 26 74.3 X Y

HW12a MC 50 46 92.0 X Y

HW12b P1 25 16 64.0 X N

Test2 P3 40 26 65.0 X N

Final Exam P2 35 28 80.0 X Y

HW13a MC 50 47 94.0 X Y

HW13b Pt2 50 46 92.0 X Y

Y Y Y Y Y Y Y Y

Assessment 

Course Learning Outcome

M
et

 T
ar

g
et

?

CLO Satisfied?

ET 5870 Engineering Project 

Management

 

Our university has a standardized instrument for 

student evaluation of teaching (SET) used throughout the 

university and administered at the end of each course 

offering. There are a total of 24 questions on the 

instrument, as well as room for optional instructor 

generated items. The SET instrument uses a rating scale 

of 1 - 5, with 5 being best. The SET was deployed in this 

course and Table IV gives the results during one 

assessment cycle for a subset of the questions on the 

instrument. These items were selected because of their 

direct relationship to evaluation of student perceptions of 

the course’s effectiveness. The average rating on each 

question is given by µ , while Md. gives the median value. 

 

Q1: How would you rate this course? 

Q2: How much have you learned in this course? 

Q4: The presentations were clear and understandable. 

Q9: The instructor encouraged student questions. 

Q24: How would you rate the instructor’s teaching? 

 

 

 

TABLE IV 
RESULTS OF STUDENT EVALUATION OF TEACHING 

Q1 Q2 Q4 Q9 Q24 

µ Md. µ  Md. µ  Md. µ  Md. µ  Md. 

3.7 4.0 4.2 4.0 4.4 4.5 4.6 5.0 4.1 4.0 

 

Table IV shows that student perceptions on the 

selected items were all favorable. In particular, the results 

for Q4 and Q9 were most gratifying. They show that the 

students found the online course materials to be clear and 

understandable, and they had ample opportunity to 

interact with the instructor through the online discussion 

features of the course delivery system.  

VIII. CONCLUSION 

The process of developing and delivering this course 

shows that with proper design, online courses can be very 

effective. The course materials should deliberately 

incorporate elements that facilitate online education. In 

particular, advantage should be taken of any appropriate 

computer based programs and tools and have them 

integrated into the course delivery. This enhances the 

value of the course and avoids the pitfall of just having an 

online textbook. Students are able to learn more 

effectively as a result. Direct measures of student 

performance on the course learning outcomes showed 

that the students had a good understanding of the course 

material well. Student evaluations of their experiences 

with the course were also very positive. This gives us 

confidence in our continuing drive to diversify the modes 

of course offerings we use and we expect to expand our 

online course delivery efforts.  
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